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Introduction 

What’s Inside 
This is the brief guide to installing and configuring the Sysgem Enterprise 
Manager (SEM) components on your systems.  

For further information see also the other available product guides (shipped with 
SEM and available from the Downloads section of the Sysgem web site). 

See also the SEM Release Notes for the latest features added to SEM. 

Available Product Guides 
Sysgem Enterprise Manager (SEM) Base Framework: 

• SEM Installation Guide 

• SEM User guide 

Sysgem System Manager (SSyM) Module: 

• SSyM SNMP Manager User Guide 

• SSyM System Manager User Guide 

Sysgem Account Manager (SAcM) Module: 

• SAcM Account Manager User Guide 

• SAcM Password Synchronizer User Guide 

Sysgem Security Manager (SSeM) Module: 

• SSeM Security Manager User Guide 

Sysgem Development Manager (SDeM) Module: 

• SDeM Development Manager User Guide 

Contacting Us 
Please contact your supplier or Sysgem AG at any time via Online Support on 
the Sysgem web page http://www.Sysgem.com. 

Sysgem Enterprise Manager Quick Start Guide (Rev3) Introduction  •  1 

http://www.sysgem.com/downloads/downloads.php3
http://www.sysgem.com/forms/c_support_form.html




Quick Start 

Sysgem Enterprise Manager 

Topology 
The Sysgem Enterprise Manager (SEM) provides companies of all sizes with a 
simple, powerful tool for managing IT, auditing security, administering user 
accounts and monitoring systems throughout the entire enterprise. 

The following diagram gives an overview of the SEM Base Framework that 
extends network-wide to all major platforms, and supports a set of management 
phases to monitor, audit, report and manage resources on those platforms: 

 

SEM 
Management 

Console 

SEM Authorization 
Server

SEM Agents 

 

A set of separately licensed plug-in application modules provides you with 
integrated system management, user account management and security 
management. These modules provide packaged solutions with comprehensive 
functionality and also support layered applications. 

With the optional development module license the SEM base framework 
provides you with a 100% open architecture. You can see all the functionality of 
the OS command language based plug-in application modules and easily 
customize them to meet your specific needs or develop your own special 
applications. 

The supported environments comprise not only platforms such as Windows 
XP/2000/NT, NetWare, UNIX/Linux, OpenVMS, OS/400, etc., but also layered 
applications such as Lotus Domino, MS Exchange, MS SQL Server, ORACLE, 
PATHWORKS, PMDF, RSA ACE/Server, SAP, Sybase, etc.  
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Components 
A workable SEM configuration consists of: 

• Three mandatory SEM Base Framework Components 

• One or more task-specific SEM Plug-In Application Modules 

• Optional SEM Application Support Packages 

SEM Base Framework Components 
For a workable SEM configuration the following three mandatory SEM Base 
Framework Components need to be installed: 

1. The SEM Management Console (the graphic user interface - GUI) 
is installed on a Windows XP/2000/NT system. This is normally on 
the workstations that will run the user interface, but it can 
alternatively be installed on a central server and accessed from 
there by the workstations. 

2. The SEM Authorization Server. This stores logon information and 
user settings and is installed on a Windows XP/2000/NT or 
Windows NT system (usually a server). 

3. One or more of the platform-specific SEM Agents currently 
available for: 

• Windows XP/2000/NT 

• NetWare1 

• OpenVMS2 

• OS/400 

• UNIX/Linux3 

1 NetWare support is contained within the standard SEM Agent software 
running on Windows XP/2000/NT. 
2 The SEM Agent for OpenVMS supports: AXP, VAX. 
3 The SEM Agent for UNIX/Linux currently supports: Compaq Tru64 (Digital 
UNIX), HP UNIX, SUN Solaris, IBM AIX, Linux on Intel Machines 
(Mandrake, Red Hat, SuSe). 

SEM Plug-In Application Modules 
For a workable SEM configuration a valid license for one or more SEM Plug-In 
Application Modules is required . The following separately licensed SEM Plug-
In Application Module components are currently available: 

1. Sysgem System Manager (SSyM) Module: 

• SSyM SNMP Manager 

• SSyM System Manager 

2. Sysgem Account Manager (SAcM) Module: 

• SAcM Account Manager 

• SAcM Password Synchronizer 

3. Sysgem Security Manager (SSeM) Module: 

• SSeM Security Manager 

4. Sysgem Development Manager (SDeM) Module: 

• SDeM Development Manager 
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SEM Plug-In Application Modules are held with the SEM Authorization Server. 
Each user in SEM is given permission to access certain Modules and Module 
features depending on settings applied to an 'Access Control Profile'. 

New versions of Applications Modules may be introduced into the system by 
using the menu option: "Import Module" from the SEM Management Console. 

Plug-In Application Modules comprise user interface definitions and script files 
that run on target systems. These definitions and script files are imported from a 
single (text) file, new versions of which can be obtained from Sysgem or your 
supplier. 

Licensed SEM Plug-In Applications Modules are normally automatically 
available after you have installed a valid license. The SAcM Password 
Synchronizer module has additional components that are installed separately. 
These components are described in a separate topic "SAcM Password 
Synchronizer" below. 

Optional SEM Application Support Packages 
SEM Plug-In Application Modules also support layered applications. The 
following separately licensed optional SEM Application Support Packages are 
currently available: 

• SEM Lotus Domino Package 

• SEM MS Exchange Package 

• SEM MS SQL Server Package 

• SEM Oracle Package 

• SEM Pathworks Package 

• SEM PMDF Package 

• SEM RSA ACE/Server Package 

• SEM SAP Package 

• SEM Sybase Package 

All licensed SEM Application Support Packages are automatically available 
after you have installed a valid license. 

Installation and Configuration 

Test System for Evaluation 
If you are installing a test system of Sysgem Enterprise Manager for evaluation 
then you can install the mandatory SEM Base Framework Components (the 
Management Console, the Authorization Server and a Windows 2000/ NT 
Agent) on a single Windows XP/2000/NT system (workstation or server). 

All available SEM Plug-In Applications Modules (exept the SacM Password 
Synchronizer) and all available Application Support Packages are automatically 
loaded after you have entered an evaluation license. 

Security Keys 
When installing SEM components you will be asked to enter your “Security 
Key”. This is a free-format, case-sensitive, alphanumeric phrase that is unique to 
your customer site. It is similar to a password, and you will need to decide on it 
and set it during the installation. It is essential that you remember it - it must be 
entered in exactly the same way for every SEM component you install on your 
network. 
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Installation on Windows XP/2000/NT Platforms 
Load the SEM CD and from the main AutoPlay menu choose “Install Kits…”. 

• Select “Install Windows XP/2000/NT Software”. 

• The InstallShield window will appear. Installation will be 
automatic. The default replies to questions are usually correct.  

• You will be prompted for an installation password. Check with 
Sysgem’s Online Support (via the Sysgem web site) for the 
password to the current version.  

Installation on Other Platforms 
Load the SEM CD and from the main AutoPlay menu choose “Install Kits…”. 

To install SEM agents on other platforms, select “Browse CD for other 
PlatformKits”. Pick the appropriate platform agent kit and copy (with ftp) to an 
appropriate directory on the target machine. 

Novell NetWare 
A separate Novell NetWare client for managing the Novell server does not need 
to be installed, since it is contained within the standard SEM Agent software 
running on Windows XP/2000/NT. The Novell management scripts are 
distributed with the SEM Plug-In Application Modules and are transmitted from 
the SEM Management Console to the standard SEM Agent runnning on 
Windows XP/2000/NT.  

OpenVMS 

Unzip the kit on OpenVMS (see Xtras folder on the CD if you do not have 
UNZIP.EXE for OpenVMS). Then perform a standard installation using 
VMSINSTAL. 

$ UNZIP :== $SYS$MANAGER:UNZIPAXP.EXE 
$ UNZIP VMS_AGENT_020_A.ZIP 
$ @SYS$UPDATE:VMSINSTAL VMSAGENT020 SYS$SYSROOT:[SYSMGR.SEMKIT] 

OS/400 

(1) The installation must be done under user profile QSECOFR. 

(2) If necessary unzip the kit into a folder on a PC which is connected to the 
AS/400. Create a save file in a library on the AS/400, and FTP the unzipped kit 
file into it.  Ensure that system value QALWOBJRST is *ALL for the Restore 
process, reset it afterwards. Restore the library SYSGEM_SEM from the save 
file to a library name of your choice. 

(3) Check for a Reply List Entry of "G" for CPA3311 in System Reply List.  If 
there is one, note the entry number for step (4).  If there isn't one, check if entry 
number 1001 is unused:  if it isn't then identify an alternative unused entry 
number.  

NOTE:  The configuration software will want to use entry number 1001 by 
default. 

(4) Set current library to the library name restored.  Call program SEMINS to 
complete installation. 
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UNIX/Linux 

FTP the unixagent020.tar file from the SEM CD to an approriate directory on the 
UNIX/Linux machine. 

# cd /kits/SEM_kit 
# tar –xvf unixagent020.tar 
# ./setup 

Entering an Evaluation License (First-Time Login) 
Log into SEM with the pre-installed SEM username and password:  

Username: System 
Password: sysgem 

You will then be prompted for evaluation license information that you have to 
type in: 

• Company/Organization name 

• City 

• Zip code 

• Country 

You are now licensed with full functionality for a limited period of 30 days. If 
you need to extend this evaluation period, contact Sysgem’s Online Support (via 
the Sysgem web site). 

Importing a Permanent SEM License 
Log into SEM and select:  

File -> Import and Export -> Import License. 

Pick the "SEM License PAK YYMMDDNN.txt" file from the "SEM_License" 
folder of your SEM CD. 
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SAcM Password Synchronizer 

Topology 
The following diagram gives an overview of the SAcM Password Synchronizer: 

   

Rules Database 

Controller 

OpenVMS UNIX 
Windows 

XP/2000/NT 

End-Users   

SEM Agents   

 

 

An end-user changes their password on their login machine. They use either the 
Password Synchronizer ‘Console’ program from Sysgem to change their 
password, or they use the standard operating system procedures and let the 
Password Synchronizer ‘intercept’ the password change. 

New passwords are sent to the SAcM Password Synchronizer Controller, which 
checks the Rules Database to determine whether each new password should be 
distributed, and if so to which target systems it should be sent. 

The Controller sends new passwords to the SEM Agents running on the target 
systems and the password is updated for the appropriate user accounts on those 
systems. 

Components 
There are four components that need to be installed on different systems: 

• Full set of SEM Base Framework Components  
–> where the Rules Database is to be maintained 

• Additional SEM Agents 
–> where the end-users changed passwords are to be sent 

• SAcM Password Synchronizer End-User Components 
–> where the end-users passwords are changed 

• SAcM Password Synchronizer Controller 
–> on at least one Windows server 
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SEM Base Framework Components  
A full set of SEM Base Framework Components is required on the System 
where the Rules Database is to be maintained. The Password Synchronizer Rules 
DB is created initially by the SAcM Account Manager module using the SEM 
Console Manager interface. 

 

 

Controllers 

Rules 
Database 

 

After the rules have been updated in a master copy of the Rules Database, they 
are distributed from the ‘SEM Management Console’ to the various SAcM 
Password Synchronizer Controllers across the network. 

The controller uses the Agents and Groups and Rules Database definitions, 
which are held in the ODBC database with System DSN Sysgem Pwd Sync. 

These definitions are maintained by two SEM displays: 

• Password Synchronization Agents and Groups, and 

• Password Synchronization Rules Database. 

SEM Agents 
SEM agents are used as part of a SAcM Password Synchronizer installation to 
update the user accounts on the target systems. The standard SEM agents must 
be installed on all the target systems where the passwords are to be updated. See 
the SEM Installation Guide for details. 

SAcM Password Synchronizer End-User Components  
End-User Components consist of the SAcM Password Synchronizer Console and 
the SAcM Password Synchronizer Interceptor: 

The Console is a Sysgem provided program that provides a command line 
prompt for a new password. It first changes the user’s password in their local 
account and then sends the new password to the SAcM Password Synchronizer 
Controller. 

The Interceptor is a Sysgem provided program that ‘listens’ for passwords being 
changed by the normal operating system procedures and sends the new password 
to the SAcM Password Synchronizer Controller. 
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Interceptors are currently available for the Windows XP/2000/NT and for the 
OpenVMS platforms. On OpenVMS they intercept password changes only when 
a user is forced to change an expired password during login.    

The Interceptor and Console have configuration files that identify the location of 
the SAcM Password Synchronizer Controllers. If a Controller is unavailable for 
any reason, then the next one in sequence will be used. 

On systems where the user will change passwords you install: 

• Interceptor (Windows and OpenVMS only): to intercept a 
password that has been changed with the normal operating system 
procedure. 

• Console programs (all platforms): a Sysgem program that prompts 
a user for a new password. 

In Windows domains a domain password is changed on the Domain Controllers. 
Passwords used in Windows workgroups are local account passwords and are 
changed on the user's own workstation.  
 
The normal use of Password Synchronizer is to intercept domain passwords and 
therefore the Interceptor is normally installed on Domain Controllers. In an NT 4 
domain install the Interceptor on the Primary Domain Controller (PDC). You 
may also install it on Backup Domain Controllers in case those should ever be 
promoted to a PDC. 

SAcM Password Synchronizer Controller 
The Password Synchronization Controller is installed on one or more Windows 
systems (workstation or server). It receives new passwords from the End-User 
Components and forwards them to target systems in accordance with the rules in 
a Rules Database. It should be installed on Windows Servers that are normally 
always available. 
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Summary 
The additional SAcM Password Synchronizer components can be summarized as 
ollows: f 
Available Platform Component Description 
Windows Interceptor This intercepts password 

changes made using any 
Windows program and 
forwards the new 
passwords to the 
Controller. 
It comprises of a DLL in 
the System32 directory that 
is called when a user 
changes a password. 
This must be installed on 
the system where the 
password is located; if in a 
domain then this is the 
PDC and BDC.  

OpenVMS Interceptor This intercepts password 
changes using LOGINOUT 
and forwards the new 
passwords to the 
Controller. 
A shareable image that 
uses the LOGINOUT 
(LGI) routines as described 
in the COMPAQ 
OpenVMS Utility Routines 
Manual to support a 
custom login program. 

Windows Controller The program that receives 
password change requests 
processes them and 
distributes the changed 
password. 
Installed on one or more 
secure Windows systems. 
These do not have to be the 
domain Controllers but 
usually are. 
The interceptor attempts to 
send the requests to each 
Controller in turn until an 
available Controller is 
found.  

Windows 
UNIX 
OpenVMS 

Console A small utility program 
with which the user 
requests a change of 
password. The Console 
communicates directly 
with the Controller. 
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Installation and Configuration 

Test System for Evaluation 
To evaluate the SAcM Password Synchronizer, for example to synchronize 
passwords in accounts on two UNIX machines, you will need to install: 

1. The SAcM Password Synchronizer End-User Components 

2. The SEM Agents 

... on the two UNIX machines, and you will also need to install: 

3. The SEM Base Framework Components 

4. The SAcM Password Synchronizer Controller 

... on a single Windows XP/2000/NT system (workstation or 
server). 

Security Keys 
You will be asked to enter your “Security Key”. This is a free-format, case-
sensitive, alphanumeric phrase that is unique to your customer site. It is similar 
to a password, and you will need to decide on it and set it during the installation. 
It is essential that you remember it - it must be entered in exactly the same way 
for every SEM component you install on your network. 

Installation on Windows XP/2000/NT Platforms 
Load the SEM CD and from the main AutoPlay menu choose “Install Kits…”. 

• Select “Install Password Synchronizer on XP/2000/NT”. 

• The InstallShield window will appear. Installation will be 
automatic. The default replies to questions are usually correct.  

• You will be prompted for an installation password. Check with 
Sysgem’s Online Support (via the Sysgem web site) for the 
password to the current version.  

Installation on Other Platforms 
Load the SEM CD and from the main AutoPlay menu choose “Install Kits…”. 

To install SEM agents on other platforms, select “Browse CD for other Platform 
Kits”. Pick the appropriate platform agent kit and copy (with ftp) to an 
appropriate directory on the target machine. 

OpenVMS 

Unzip the kit on OpenVMS (see Xtras folder on the CD if you do not have 
UNZIP.EXE for OpenVMS). Then perform a standard installation using 
VMSINSTAL. 

$ UNZIP :== $SYS$MANAGER:UNZIPAXP.EXE 
$ UNZIP VMS_PWDSYNC_020_A.ZIP 
$ @SYS$UPDATE:VMSINSTAL VMSPWDSYNC020 SYS$SYSROOT:[SYSMGR.SEMKIT] 

UNIX/Linux 
FTP the UNIX_pwdsync_020.tar file from the SEM CD to an appropriate 
directory on the UNIX/Linux machine. 

# cd /kits/SEM_kit 
# tar –xvf UNIX_pwdsync_020.tar 
# ./setup 
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Entering an Evaluation License (First-Time Login) 
When you first use the Password Synchronizer Controller you will be prompted 
for evaluation license information that you have to type in: 

• Company/Organization name 

• City 

• Zip code 

• Country 

You are now licensed with full functionality for a limited period of 30 days. If 
you need to extend this evaluation period, contact Sysgem’s Online Support (via 
the Sysgem web site). 

Run the Password Synchronizer Controller by using the Windows menu option: 

    Start>Programs>SYSGEM>PwdSync>Controller 

Define security keys by using the Controller main window menu option: 

    Options>Security Keys 

Importing a Permanent SEM License 
Run the  Password Synchronizer Controller and select:  

File -> Import License. 

Pick the "SEM License PAK YYMMDDNN.txt" file from the "SEM_License" 
folder of your SEM CD. 
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